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Imperx thanks you for purchasing the Imperx Toolkit User Manual. We are certain that the program’s many 

advanced features and easy-to-use format will meet and exceed your expectations.  

 

This Imperx Toolkit User Manual is provided as an additional service to guide you in using our program 

optimally. Our staff is available to answer any questions or concerns you may have. We can be reached at: 

 

 

Email: support@imperx.com  
Toll Free 1 (866) 849-1662 or (+1) 561-989-0006  

Fax: (+1) 561-989-0045  

Visit our Web Site: www.imperx.com  

 
 
Imperx designs and manufactures high performance cameras, frame grabbers and industrial imaging 

systems used in the machine vision, medical, military, surveillance and automation markets. Our multi-service 

brand is recognized for superior performance, reliability, accuracy, and cutting-edge design. Headquartered 

in Boca Raton, FL, with offices and distributors worldwide, Imperx international standards registrations are:  

 
Quality Management System ISO 9001:2015 Registered 
Environmental Management System ISO 14001:2015 Registered 
DDTC Registered (Directorate of Defense Trade Controls, US Department of State) 

 

 

 

mailto:support@imperx.com
http://www.imperx.com/
http://www.imperx.com/
http://www.imperx.com/
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1 General Information 

The Imperx Toolkit application provides a set of functions to view and analyze images 

acquired from the Imperx equipment.  

 

The following table specifies the Imperx equipment that can be used to acquire images: 

  

Imperx Equipment 

Framelink Express, a Camera Link frame grabber 

HD-SDI Express, a frame grabber 

Imperx GigE Vision cameras 

Imperx USB3 cameras 

Imperx Camera Link cameras, used with Framelink Express frame 

grabbers 

Imperx HD-SDI cameras, used with HD-SDI Express frame 

grabbers 

 

It is not guaranteed the image file, created with other software and hardware can be opened 

by Imperx Toolkit. 
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2 Installation 

The Imperx Toolkit Application can be installed as follows. Please use the Windows Explorer 

to change directories to the location of where the IpxTK_X_X_X_X.exe has been 

downloaded. 

 

1. Double click the IpxTK_X_X_X_X.exe.  

An initial Imperx Toolkit Setup Wizard opens. Note the recommendation to close other 

applications and then click Next to continue with the installation process. 

 
 

2. When the License Agreement screen appears, read the agreement and click I Agree.  
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3. On the Choose Components screen, select all the Imperx Tool Kit components and click 

Next. 

 
 

4. On the Choose Install Location screen, accept the default destination folder or click 

Browse and select a different location, click Next and then Install. 

 
 

 

 

 

 

 

 

 



 

Imperx Toolkit User Manual 

 

IMPERX, inc.  Rev. 1.1 
6421 Congress Ave Ste. 204  09/30/20 
Boca Raton, FL 33487 USA 

Page 8 of 47 

The installer prompts you to uninstall any existing versions of the software from your 

computer before continuing the installation. 

 

 

 

5. Click Finish to complete the installation procedure. 

Two icons—IpxToolKit and IpxToolKit (32b)—appear on your desktop. 
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3 Main Window 

The Imperx Toolkit application graphic user interface allows the user to view and analyze 

images.   

3.1 Overview 

The Imperx Toolkit application can be launched by double clicking on the shortcut icon 

  or . 

The following Imperx Toolkit application main window opens.  

 

The Imperx Toolkit main window consists of the: 

• Menu bar  

• Toolbar 

• Directory view window 

• File list view window 

• Display window 

• Dialog bar 
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3.2 Menu Bar 

The menu bar consists of the menus:  File, Tools, and Help. 

 File Menu 

The File popup menu includes the options to open or save image files: 

• Open     Opens the image or movie file from the hard drive. 

• Save As     Saves the image file to the hard drive. 

• Recent files list    Displays a list of most recently opened files. Click on 

     recent file to open. 

• Exit     Closes the application. 

 

 Tools Menu 

The Tools popup menu includes the options to open a specific tool to analyze opened image 

or create a service file (DPM, HPM, FFC, LUT) that can be used by the Imperx cameras or 

frame grabbers 

 

 
 

• Hex Pixel Dump   Opens the Hex Pixel Dump panel to analyze the image 

     pixels. 

• Video Options   Opens the Video Options dialog box to view and  

     modify the options for Movie Viewer. 
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• Video Information  Opens the Record Info dialog box to view information 

     about currently opened movie 

• DPC/HPC Utility   Opens the DPC/HPC utility to create Defect Pixel 

     Map or Hot Pixel Map files. See section DPC/HPC 

     Utility for details. 

• FFC Utility   Opens the FFC utility to create Flat Field Correction 

     file. (See FFC Utility for details.) 

• RGB Filter   Opens the RGB Filter panel. This panel provides  

     White Balance and Color Correction options. 

• LUT Manager   Opens the LUT Manager utility to create or modify 

     Look Up Table. See section 5 LUT Manager for 

     details. 

 Help Menu 

The Help popup menu includes the option About Toolkit. 

 

 
 

Clicking on the About ToolKit menu item opens the About Imperx Toolkit dialog and shows 

information about the software version and technical support contact information. 
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3.3 Toolbar 

The Toolbar is composed of the following buttons. Each option is described below. 

 

 
 

•    Open.       Open image or movie file from hard drive     

 

•    Save As.  Save image file to hard drive  

 

•    Zoom In. Increases the scale of image display 

 

•    Zoom 1:1. Sets the 1:1 scale of image display 

 

•    Zoom Out. Decreases the image display scale 

 

•    Full Screen. Opens the Display window to full screen. You can press the <Esc> key to 

go back to normal mode. 

•  Hex Pixel Dump. Opens the Hex Pixel Dump panel to analyze the image pixels. 
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3.4 Directory and File List View 

A Directory View tree-control window, File Filter Combo Box, File List Window, Edit Box, 

and View button are shown below: 

 

 
 

The Directory View includes a tree-control window that allows you to explore and change 

the current folder where the target image files are located. After selecting the folder, the files 

located inside the folder will be displayed in the File List Window.    

 

The File Filter Combo Box will only display the file format(s) selected in the File List 

Window. 
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The supported file types for the File Filter Combo Box are the following: 

 

• RAW (*.bin, *.raw, *ixi)   

• JPEG (*.jpeg, *.jpg, *.jpe)  

• TIFF (*.tiff, *.tif) 

• PNG (*.png) 

• BMP (*.bmp) 

• AVI (*.avi) 

• Supported Formats (RAW, IXI, JPEG, TIFF, PNG, BMP, AVI) 

• All Files (*.*) 

The Refresh Button   is used to update the File List Window with the corresponding 

supported file formats located in the selected folder. 

 

The Edit Box displays the file name from the File List Window that has been selected by the 

mouse click or last viewed image.  

 

The View button enables you to view the selected image file from the File List Window or 

last viewed image entered in the edit box on the Display Window.  For example,  

 

 
 

 

 

 

 

ATTENTION! Only the images and movie files, saved in the 

BobcatGEVPlayer, IpxPlayer, Framelink Express, and HD-SDI Express 

applications are guaranteed to be opened. 
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3.5 Display Window 

The Display Window shows the currently opened image file or movie. It is possible to drag 

the view by pressing the left mouse button and zooming with the mouse wheel. The scroll 

bars can be used to move the view in the vertically and horizontally direction. The Right 

mouse button click calls the Display popup menu.  

 

The Display popup menu includes following options: 

 

 
 

• Zoom In [Hotkey ‘+’].   Increases the display view scale 

• Zoom Out [Hotkey ‘-’].   Decreases the display view scale 

• Set fit mode…   Selects whether the image is fully or partially visible. 

 

o Fit to Window [Hotkey ‘0’] Sets the scale to fit the currently opened image in the 

display window. The full image will be visible on the display view. 

o Fill Window [Hotkey ‘2’] Sets the scale to fit the currently opened image to 

display window in one dimension (horizontally or vertically). The image will be 

partially visible on the display view, depending on display view and image 

dimensions. 

• Set zoom…   Changes the image display view scale. 

 

o 25%    Sets the display view scale 1:4. 

o 50%    Sets the display view scale 1:2. 

o 100% [Hotkey ‘1’].   Sets the display view scale 1:1. 

o 200%    Sets the display view scale 2:1. 
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• Center at…   Changes the image display view center point 

 

o Image Center [Hotkey ‘C’] Sets the display window center to center of image. 

o Here [double click]  Sets the display window center to mouse pointer 

     position. 

• Show HexPixelDump  Opens the Hex Pixel Dump panel to analyze the image 

                                                     pixels. 

3.6 Dialog bar. Image Viewer 

If the image file is opened, the dialog bar displays options to control the parameters for image 

loading, displaying and conversion. This consists of three panels—status bar, Image 

Properties, and Converting. 

 Image Properties Panel 

The Image Properties panel provides options to control the parameters used for image 

displaying.  

 

 
 

• Device Type   Selects the type of device where the image was acquired. 
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ATTENTION! Images acquired from Imperx CameraLink and HD-SDI 

cameras are guaranteed to be loaded and displayed properly only if the Imperx 

frame grabber (FrameLink Express or HD-SDI Express) was used. 
 

• Width and Height  Set the RAW image horizontal and vertical size. 

• Learn    Returns width and height of the image. 

• Interlaced    Allows to analyze interlaced images from the analog 

                                                      VCE Express and HD-SDI Express frame grabber. 

• To Grayscale   Makes the color image to be displayed as grayscale. 

• Pixel type    Defines the way how the pixels are stored in the RAW 

                                                       file. 

Each device type has its own set of pixel type: 

o For GigE Vision camera: 

 

Please see a camera’s user manual for details about the listed pixel types. 

o For FrameLink Express frame grabber:  

  

Please see the FrameLink Express Hardware user manual for details about the listed 

pixel types. 

o For HD-SDI Express frame grabber:  

  

Please see the HD-SDI Express Hardware user manual for details about the listed 

pixel types 
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o For VCE-Express frame grabber:  

 

Please see HD-SDI Express Hardware user manual for details about the listed pixel 

types. 

 

• Taps    Specifies the number of camera sensor taps.  

This option is active only for the images acquired from 

FrameLink Express frame grabber. 

 

 

 

• Bit Shift    Shifts each pixel value left or right to make the image 

                                                      darker or brighter.  

This option can be important for images with 10, 12, 14 

bits per pixel.  

 

In the case that the image is non-normalized (pixel value 

is located in less valuable bits of 16 bit word), then it is 

necessary to use the bit shift option to have the image 

display properly. 

 

. 
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• TrueSense    Check the TrueSense option for RAW images acquired 

                                                      from the Imperx color camera with  

                                                      TrueSense Sparse Color Filter Array (CFA).  

 
 

The Radio buttons P, B, G, R represents the TrueSense Sparse CFA start pixel—

Panchromatic, Blue, Green, Red—for the sensor’s left-top pixel.  

 

It is set to the first Panchromatic component by default, that is correct for all Imperx 

cameras with TrueSense Sparse CFA. However, if the image was acquired in the AOI 

mode, then the pattern start should be set according to the AOI Left, Top positions. 

 

The Algorithm combo box provide options to modify the demosaicing algorithm type.  

It includes: 

o Simple Fast     Simplest and fastest algorithm. Provides average quality 

     and best time performance. 

o Simple quality  Quality and fast algorithm. Provides good  quality and 

     good time performance. 

o Bayer Like Fast  Algorithm, based on Bayer CFA demosaicing. Provides 

     good quality and good time performance. 

o Medium   High quality algorithm. Provides high quality and 

     average time performance. 

o Quality   Highest quality. Provides highest quality and low time 

     performance. 
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• Bayer pattern Check Bayer pattern option for RAW images acquired from 

                               Imperx color camera with Bayer Color Filter Array (CFA). 

 
 

The Radio buttons GR,  RG, BG, GB represent the Bayer Sparse CFA start pixel—Green- 

Red, Red-Green, Blue-Green, Green-Blue—for the sensor’s left-top pixel.  

 

It is set to GR by default. That is the default for all the Imperx cameras with Bayer CFA. 

However, if the image was acquired in AOI mode, the pattern start should be set 

according to the AOI Left/Top positions. 

 

The Algorithm combo box provide options to modify the demosaicing algorithm type.  

It includes: 

o Simple    High quality linear interpolation algorithm. Provides

     good quality and best  time performance. 

o Gradient   Gradient-based algorithm. Provides high  quality, and

     good time performance. 

o AHD    Adaptive Homogeneity-Directed Interpolation 

     algorithm. Provides the best quality, but poor time 

     performance. 
  



 

Imperx Toolkit User Manual 

 

IMPERX, inc.  Rev. 1.1 
6421 Congress Ave Ste. 204  09/30/20 
Boca Raton, FL 33487 USA 

Page 21 of 47 

 Converting Panel 

The converting panel provides options for batch conversion of series of images to commonly 

used format (TIFF, BMP. JPEG, PNG) and AVI movie file. 

 

 
 

The current folder of the input image files is indicated in the text field at the top of the panel. 

The current folder can be changed from the Directory View window.  

 

The group Write AVI from input series of images includes the options for batch AVI 

creation: 

• Path to result AVI file   Browse button opens the dialog box to set the AVI file

     path and name.  

• Write. Starts the AVI conversion procedure 

• FPS    Value of Frames Per Second of result AVI file 

• Compression   Allows to select the AVI compressor and configure it. 
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The group Convert input series of images includes the options for batch image file 

conversion: 

• Path to result files folder  Browse button opens the dialog box to set the output 

     files folder. 

• Output image file format 

o TIFF     8bpp TIFF for 8bpp input images, 16bpp TIFF for  

     10,12,14,16bpp input images  

o BMP    24bpp Bitmap for color images or 8bpp grayscale for 

     mono images 

o JPEG     Default JPEG quality is 85% 

o PNG 

o RAW 

 

• Convert     Starts the image file conversion procedure 

 Status Bar 

The Status bar displays the following information: 

 

 

• File name    Currently opened image file name 

• Cursor position   Position of cursor on displayed image 

• Pixel value    Value of displayed image pixel under the cursor  

• Scale    Current value of display window scale 

• Size     Opened image file size in bytes 
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3.7 Dialog Bar. Movie Viewer 

If the movie file is open, the dialog bar provides options to view and inspect the movie.  The 

dialog bar includes the options:  

• view movie properties  

• play the movie forward/backward  

• add/remove markers and crop the interested part of the movie 

 

 
 

 

• File name    This field displays the currently opened file name. 

 
 

• Rate    The rate option allows you to change the playing frame 

     rate of viewing movie. It can be decreased from actual 

     value 100% down to 1%, and allows to slowdown the 

     playing of high-speed records. 

 

The rate can be changed using the slider as well as the spin button editing the box. 

 

 

ATTENTION! It is possible to experience with the lagging and jerking while 

movie playing, if the movie file read speed (for example if the PC hard drive is 

slow) is slower than playback speed. To prevent the lagging and jerking, 

please decrease the playing frame rate. 

 

• Playback controls   The Playback control includes the controls to play and 

     inspect the movie.  

 
 

The Track slider allows the user to view the current position of the movie being played, 

set the playing start position (light-gray marker), and set the playing end position (dark 

marker).  
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The user can drag the markers to change the current, start and finish positions. The values 

under the slider indicate the first and last frame numbers of the opened movie. The values 

below the slider show the start and end time in ‘hh:mm:ss:ms’ format. The green progress 

line indicates the loading. 

 
 

The Start, Current, End edit fields allows the user to view and modify the markers 

position.  

 

The upper fields are editable and user can set frame number for each marker. The lower 

fields are read-only and show marker time in ‘hh:mm:ss:ms’ format. 

 

• Movie view control buttons The movie control buttons shown below: 

 Stop Stops the movie playing. 

 Go to Beginning Moves the playback marker to first frame of the movie. 

 Play Backward Plays the movie in backward direction. 

 Step Backward Moves the playback marker one frame backward. 

 Pause Pauses the movie playing. 

 Step Forward Moves the playback marker one frame forward. 

 Play Forward Plays the movie in forward direction. 

 Go to End Moves the playback marker to last frame of the movie. 

 
Loop When pressed, the movie playing will be started 

automatically repeat after finishing. 
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 Record Info 

The Record Info dialog box can be opened from the menu option Tools->Video Information. 

It shows the properties of the currently opened movie file properties. 

 

 
 

The Record Info dialog box includes the following information: 

 

• Frame size     The size of the Width [pix] x Height [pix]. 

• Frame Rate    The Frame Rate Per Second value. 

• Frame Count    The number of frames in the opened movie. 

• Duration     The movie duration in ‘hh.mm.ss.ms’ format. 

• Codec Info     The name of the movie codec. The ‘raw video’ format

     indicates an uncompressed video. 

 Video Options 

The Options dialog box is used to view and modify the Buffer Size options of the Movie 

Viewer. This dialog box can be opened from the menu bar option Tools->Video Options. 

 

 
 

The Video Options dialog box defines the size of the buffer used by the application playing 

the movie files. The buffer is pre-loaded before starting the movie and then loaded into the 

background while the movie is played.  

• Frames count    Check this option to specify the buffer size in number of 

     movie frames. 

• Memory size (MB)   Check this option to set the buffer size in Mega Bytes. 

• Display buffer.    Check this option to display the buffer loading progress

     status on the Track Slider. 
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4 Hex Pixel Dump 

The Hex Pixel Dump panel shows pixel values in the table in hex format. The Active area is 

highlighted with the yellow frame on the Display window.   

 

The row number of the table is image line number.  

 

The column number is the line’s pixel number.  

 

 
 

The pixel value for the color images is shown in RGB values for color images, and in Y 

(luminosity) values for monochrome image.  

 

The visibility of the Pixel Hex Dump panel can be changed by the button on the Toolbar or 

menu option Tools-> Hex Pixel Dump. 
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5 LUT Manager 

The LUT Manager Window opens up tools to create or modify the LUT tables.  

 

The LUT Manager consists of the: 

• Menu bar 

• LUT toolbar 

• Formula edit box 

• LUT graphic panel 

• Customize LUT panel 

• Shortcut key combinations 
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5.1 LUT Menu Bar 

The Menu bar contains of the menus: File, Edit, View, and Help. 

 LUT File Menu 

The File menu includes options to open or save image files: 

 

 

• New    Opens a Create LUT dialog box. The dialog box looks 

     as follows: 

 

o LUT Type Selection  Selects the LUT type: Grayscale LUT or Color LUT. 

o Input values bits depth Selects the number of input values bit depth ranging 

     from 1 to 16. 

o Output values bits depth Selects the number of output values bit depth ranging 

     from 1 to 16. 

o OK    Creates LUT for the selected input/output bit depth 

     relationship. 

o Cancel     Cancels the LUT. 

• Open    Opens an existing LUT file for the file formats  

     (.lut,  .lutx, and .csv). 
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• Load a Reference   Opens an existing LUT file. In this mode, the file 

     reference signal cannot be edited. However, one is 

     capable of displaying the reference curve when clicking 

     on the Reference legend. 

• Save    Saves the LUT file to a user defined path. 

• Save As…    Saves the LUT file to a user defined path. 

• Quit    Closes the LUT Manager dialog box. 

 

 LUT Edit Menu 

The Edit menu includes the option convert dialog as shown below: 

 
 

The Convert Dialog option opens a Convert LUT dialog box: 

 
 

• Input values bit depth  Selects the number of input values bit depth ranging 

     from 1 to 16. 

• Output values bit depth  Selects the number of output values bit depth ranging 

     from 1 to 16. 

• Color Option   Grayscale or Color  

 

 

 

• Color    RGB Color Space or HSV Color Space 
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• Convert    Converts existing open LUT to corresponding color 

     space. 

• Close    Closes the Convert LUT dialog box. 

 

 LUT View Menu 

The View menu includes the following options:  

 
 

• Zoom In    Increases the scale of LUT display image. 

• Zoom Out    Decreases the scale of LUT display image. 

• Zoom Base   Sets the 1:1 scale of the LUT display image. 

• Go To Cell    Opens a Go to Cell dialog box. 

 
 

o Cell Location    Cell location (index) within LUT. 

o Go To    Opens LUT and places blinking cursor on 

     corresponding cell location. 

o Close    Closes the Go to Cell dialog box. 

• Apply LUT File   Applies the LUT displayed on LUT graphic panel 

     to the image opened in the display window. 

• Undo Applying   Removes changes made by the applied LUT. 
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• Formula Tool Bar  Toggles between showing/hiding the Formula edit 

     box. 

• Main Tool Bar   Toggles between showing/hiding the LUT toolbar. 

• All In One Tab Mode  Toggles between showing LUT individual tabs 

     components versus all in one tab mode toolbar.  

The LUT Individual Tab mode displays each color component in different tabular graph 

representation: 

 

 
 

The LUT All In One Tab mode is capable of display all color components and reference 

on one graphic representation: 
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 LUT Help Menu 

The Help menu includes the option About that opens About Imperx LUT Manager dialog, 

and shows information about software version and technical support contacts. 

          

5.2 LUT Toolbar 

The LUT Toolbar contains the following options:  

 

 

•    Create LUT   Open the Create LUT dialog box. 

•    Open   Opens the File Open dialog BOX. This dialog box is

     used to open the LUT file. 

•    Save As…   Opens the File Save Dialog Box. This dialog box is 

     used to save the LUT file. 

•    Convert   Opens the Convert dialog box. 

•    Go To Cell   Opens the Go to Cell dialog box. 

•    Zoom In   Increases the scale of LUT display image. 

•    Zoom Out   Decreases the scale of LUT display image. 

•    Zoom 1:1   Sets the 1:1 scale of the LUT display image. 
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5.3 Formula Edit Box 

The Formula edit box can only be used when Curve type is set to Dots. The Curve type 

setting will be described later. The user is able to customize the formula. 
  

 
 

In the formula, you can use the following operations: 

 

Operations Description 

+ Addition 

- Subtraction 

* Multiplication 

/ Division 

^ Raised to the power of 

cos Cosine function 

sin Sine function 

tan Tangent function 

acos Arc-Cosine function 

asin Arc-Sine function 

atan Arc-Tangent function 

sqrt Square root 

ln Log natural 

exp Exponent 

X x-value 

Pi Pi mathematical constant approximately 

3.1415926535897932 

[lower_limit:upper_limit] Set up a range for a formula by using brackets before a 

formula expression 

 

Example using range:  

 

[0:255](x + 100) /  x[256:511]x ^ 2. 

If there are no brackets, then the formula expression will be calculated on the entire range 

from 0 to maximum Input value. 

 

Example using Sine function:   

 

(4095/2) * (sin((x/(4095/4))*(2*pi)) + 1) 

This example represents a sine with period of 4095 / 4 (approximately 1021) points. 
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Example programming Gamma function: 

 

(4095 / (4095^0.45)) * (x^0.45)  

 

This example represents the gamma function y = K * (x^gamma) 

5.4 LUT Graphic Panel 

The LUT graphic panel displays the LUT plot. An example is shown below: 

 

  

 LUT Panel Window 

The x-axis represents the Input values of incoming pixels. The y-axis represents the Output 

values of the pixels. The bottom left corner of the LUT graphic panel shows location of the 

pixel coordinate in relationship to the graph. You will see a cursor that looks like a cross + on 

the curve.  

• Component Tabs   The tabs will let you load either the Grayscale, R, G, or 

     B components of the LUT. These are located in the top 

     left corner side of the panel window. When pressed, the 

     corresponding component will display the 

     corresponding LUT channel or Grayscale LUT in the 

     panel window. 

• LUT title    The title bar above the LUT graphic curve describes the 

     type of curve being displayed as well as corresponding 

     component. The possible graphic type of curves are as 

     follows: Grayscale LUT (Spline), Grayscale LUT(Line), 

     Grayscale LUT (Dot), Red Channel (Dots),  

     Red Channel (Line), Red Channel (Spline),  

     Green Channel (Dots), Green Channel(Line),  

     Green Channel(Spline), Blue Channel(Dots),  

     Blue Channel(Line), and Blue Channel (Spline). 
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• Show Table   Toggles between showing/hiding the LUT. It 

     shows the input/output pixel data value mapping. 

• Legend   Interactive Legend of Color and Reference 

   components. By default, either the Red color component 

   (Color LUT only) or the grayscale component 

    (Grayscale LUT) is displayed. Clicking on the Legend 

   Color or Reference field causes corresponding LUT 

   channel or reference to be displayed. 

• Customize   Toggles between the showing/hiding of the Customize 

   LUT panel. 

5.5 Customize LUT Panel 

The Customize LUT panel allows the user to modify or create custom LUT. The default panel 

window has vertical sliders as shown below: 

 

 
 

• Vertical Sliders   The vertical slider works as follows. The Edit Box  

     located on the top of the slider corresponds to the Input 

     pixel coordinate on the curve line. The Edit Box located 

     on the bottom of the slider corresponds to the Output 

     pixel coordinate on the curve line. The input/output 

     coordinate is represented as a black point on the curve 

     line  . We can move the input location of the 

     point on the graphic by editing the top Edit Box. The 

     Slider moves the output point value. You can see the 

     point on the curve move to a new output location. 
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• Curve Point    The point maps the input/output coordinate on the LUT 

     curve. 

 

Note:   The multiple slider represents multiple input/output points on the graphic. These 

points can be altered by either editing the input/output edit box or moving the sliders. 

 

 

• More    Displays additional custom parameters. 

 

 

• Quantity of Sliders   Creates the corresponding number of sliders on the 

     Customize LUT panel window. The range of sliders 

     allowed are from 1 to 30 sliders. 

• Distribute    Distributes the exact number of points entered in the 

     quantity of sliders. 

• Curve Type   The curve type supported are Dots, Lines, and Spline. In

     Dots mode, the user is allowed to change every point  

     (x value) by using the table representation on the right

     or moving a slider at the bottom, that was connected  

      (referenced) with desired x-axis value. Also, the Output

     values can be altered by dragging, moving and 

     dropping. In Line and Spline modes, the user can only 

     change x values that have been referenced before   

     (shown as big black point on a plot) by the same ways 

     as in Dots. In these modes if the user modify one value, 

     some other values will be changed indirectly due to 

     calculation of line or spline values. 
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• Formula    The Formula combo box is only valid in the Dots Curve

     Type mode. The user is able to use None, Gamma,  

     Linear, or User defined formula. 

o None    No formula 

o Gamma    Gamma formula, for example     

      

o Linear    Linear formula, for example    

o User    User defined formula. Refer to the section  

     5.3 Formula Edit Box for available operands  

 

• Less Button   Hides the additional parameters the user is able 

     customize. Only shows the sliders. 

5.6 Shortcut Key Combinations 

The following are a table list shortcuts for the LUT Manager: 

 

Shortcut Key Combination Description 

Mouse Left Button + Mouse Move to move the plot 

Ctrl + Mouse Left Button + Mouse Move to select a zoom rectangle 

Ctrl + Mouse Right Button to zoom to the base 

Ctrl + Shift + Mouse Left Button to zoom in one position on the zoom stack 

Ctrl + Shift + Mouse Right Button to zoom out one position on the zoom stack 

Ctrl + Shift + B to zoom to original size (base) 

Ctrl + Shift + I to zoom in 

Ctrl + Shift + O to zoom out 

Alt + Mouse Left Button to set reference value (add a slider) 

 

Note: You can change reference value by moving a slider, changing value in a edit box or 

you can just drag and drop a reference value that is displayed as a point on the plot. 
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6 DPC/HPC Utility 

The DPC/HPC Utility Window provides the tools to create the files for Defect Pixel 

Correction (DPC) and Hot Pixels Correction (HPC). These Utility allows to create the Defect 

Pixel Map (DPM) and Hot Pixel Map (HPM) files.  

6.1 Hot Pixels Map  

To create the HPM file, please prepare the series of test RAW or IXI image files, acquired 

from the Imperx camera with long exposure (about 1 second or more), with dark grey or even 

black image.  

 

1. Make sure that the camera resolution is set to maximum, and Hot Pixel Correction is Off, 

and Defect Pixel Correction is On. 

2. Set the longest exposure time and slowest frame rate expected. 

3. Cover a lens with a lens cap or dismount the lens and put a dust cap on the camera. 

4. Run the camera for at least 45 minutes at ambient temperature around 18–22 °C or higher. 

5. Capture an image (or series of images) and save it in RAW or IXI format.  
It is preferable to save 12 bpp test RAW or IXI images.  

6. Open the test RAW or IXI images with Imperx Toolkit. 
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7. Select Tools->DPC/HPC Utility menu option. 
The DPC/HPC Utility window appears.  

8. Select the Hot tab to start the Hot Pixel analysis.  

 

9. Click Browse Files to open a single RAW file or Browse Dir to open a series of RAW 

files from the selected folder.  
The opened file or files should be the same or from the same series (i.e. acquired from the same 

camera with the same pixel type) that was opened before in the Imperx Toolkit. 

After the files appear in the Files list, the histograms of files included to the list appear in the 

histogram window. The files are loaded in cycle, one by one with rate about one image per 

second. 
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10. Set Max. Pixels to a value appropriate for your camera. 

 

Camera model Max. Pixels in HPM 

CLF-C4180, CLF-C4181, CLF-C5180 

GEV-C4180, GEV-C4181, GEV-C5180 

10G-C4180, 10G-C4181, 10G-C5180 

POE-C1911, POE-C2000, POE-C2010, POE-

C2400, POE-C2410, POE-C3210, POE-C4010, 

POE-C4110 

P67-C1911, P67-C2010, P67-C2410, P67-C3210, 

P67-C4010, P67-C4110. 

POE-C4410, POE-C5410, POE-C6410 

CLF-C1921, CLF-C2020, CLF-C2420, CLF-

C3220, CLF-C4020, CLF-C4120, CLF-C4420, 

CLF-C5420, CLF-C6420 

4096 

U3V-C4180, U3V-C4181, U3V-C5180 8192 

 

11. Move the Threshold slider to the value that you want to be the minimum.  
The pixels with higher luminosity will be treated as hot 
 

You also can set the threshold value with the mouse left button click on the histogram window. 

 

12. Click Start to start the analysis of the images for hot pixels. 
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The hot pixels are added to the List of Detected Pixels table. The table includes the 

following columns: 

• Number   A hot pixel number. 

• Value    Pixel luminosity. If multiple images are used for 

     calculation, the minimum value is shown here  

      for hot pixels. 

• X, Y    Pixel coordinates. 

• Type    Pixel type. H – hot pixel. 

13. Fill the Camera and Serial # fields and click Save To File to save calculated data to 

HPM file. 
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6.2 Defect Pixels Map 

To create the DPM file, please prepare the series of test RAW or IXI image files, acquired 

from the Imperx camera with regular free run exposure, with grey image. It is recommended 

to use uniformly ambient light source, connected to the camera lens mount. In the case, if you 

do not have such a light source, you can dismount the lens, and cover the lens mount hole 

with paper. 

 

1. Make sure that Trigger Mode and Exposure Mode are set to Off, the camera resolution is 

set to maximum, and Defect Pixel Correction is Off, and Hot Pixel Correction is On. 

2. Capture an image (or series of images) with a uniform light source illuminating the sensor 

at about 50% ADU capacity (~2000 for 12-bit, ~500 for 10-bit, ~130 for 8-bit modes) and 

Save the image(s) in RAW or IXI format. 
It is preferable to save 12 bpp test RAW images. 

3. Open the test RAW or IXI images with Imperx Toolkit. 

 

4. Select Tools->DPC/HPC Utility menu option. 
The DPC/HPC Utility window appears. 

5. Select Dark & Bright tab to start the defect pixel analysis. 

6. Click Browse Files to open a single RAW file or click Browse Dir to open the series of 

RAW files from selected folder.  
The opened file or files should be the same or from the same series (i.e. acquired from the same 

camera with the same pixel type) that was opened before in the Imperx Toolkit. 
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After the files appear in the Files list, the histograms of files included in the list appear in the 

histogram window. The files are loaded in cycle, one by one with rate about one image per 

second.  

 

7. Set Max. Pixels to a value appropriate for your camera. 

Camera model Max. Pixels in DPM 

CLF-C4180, CLF-C4181, CLF-C5180 

GEV-C4180, GEV-C4181, GEV-C5180 

10G-C4180, 10G-C4181, 10G-C5180 

512 

U3V-C4180, U3V-C4181, U3V-C5180 

POE-C1911, POE-C2000, POE-C2010, POE-

C2400, POE-C2410, POE-C3210, POE-C4010, 

POE-C4110 

P67-C1911, P67-C2010, P67-C2410, P67-C3210, 

P67-C4010, P67-C4110 

POE-C4410, POE-C5410, POE-C6410 

CLF-C1921, CLF-C2020, CLF-C2420, CLF-

C3220, CLF-C4020, CLF-C4120, CLF-C4420, 

CLF-C5420, CLF-C6420 

1024 

8. Move the Dark slider to the values that you want to be the maximum for dark pixels. 
The pixels are treated as dark if their luminosity is lower than the Dark limit. 
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9. Move the Bright slider to be the minimum for bright pixels.  
The pixels are treated as bright if their luminosity is higher than the Bright limit.  

 
You also can set the threshold values with the left mouse button click for dark pixels and right 

mouse button for bright pixels on the histogram window.  

10. Click Start to start the analysis of images for dark and bright pixels. 

 

The bright and dark pixels are added to the List of Detected Pixels table. The table 

includes the following columns: 

• Number   Detected pixel number 

• Value    Pixel Luminosity. If multiple images are used for 

     calculation, the minimum value is shown here for  

     Bright pixels, and maximum value for Dark pixels. 

• X, Y    Pixel coordinates. 

• Type    Pixel type. B – bright defect pixel, D – dark defect 

     pixel. 

11. Fill the Camera and Serial # fields and click Save To File to save calculated data to the 

DPM file. 

 

 

ATTENTION! Pixels that present in List of Detected Pixels table as Hot 

and Bright at the same time, will be treated as Hot. 
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7 RGB Filter  

The RGB Filter window provides options for the white balance calculation and color 

correction: 

 

• RGB Offset   Group of controls that allows you to modify the offset 

     value for Red, Green and Blue components of the 

     loaded image. You can modify the values by slider 

     and Edit field or click Zero to reset the value to zero. 

     Check the Link check-box to link the Red, Green  

     and Blue values together, so change of one component 

     will cause the same change on all the color components. 

• RGB Gain    Provides options to change the Gain coefficient value 

     for Red, Green and Blue components. You can modify 

     the values by editing the field. Clicking Unity resets the 

     values to 1.0.  

• White balance   Calculates the Red, Green, and Blue gain values for 

     White balance. Click Analyze to calculate the gain 

     values. Click Use to assign the calculated values  

     to RGB Gain group.  

• Apply    Applies the currently set values to the image currently 

     loaded in the Imperx Toolkit 
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8 FFC Utility 

The FFC Utility provides the tools to create the files for Flat Field Correction (FFC). To start 

the image analysis for Flat Field, please prepare the sample files, acquired by the target 

Imperx camera with environment specific to your task. It is recommended to acquire 12 bit 

per pixel RAW image with average pixel luminosity about 2000-3000.  

 

Before you call the FFC Utility, open the created sample image in the Toolkit application, and 

then select Tools-> FFC Utility menu item. 

 

 
 

The display window on the left top side shows the original image. The image with the applied 

FFC is shown on left bottom side.  

 

Right top graphs show the vertical (blue, calculated for columns) and horizontal (yellow, 

calculated for lines) average luminosity. The right bottom shows average luminosity graphs 

after the applied FFC. 

 

• Title    FFC title 

• Camera    Camera model number 

• Save    Saves the FFC to file 

• Normalize FFC to  If Normalize FFC to check-box is not set, the average 

     luminosity of columns and lines of result image is the 

     same as average luminosity of columns and lines of 

     source image. 
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     If Normalize FFC to check-box is set and the 

     coefficient is specified, the peak luminosity of the 

     columns and lines of the result image equals the peak 

     luminosity of columns and lines of source image, 

     multiplied by specified coefficient. 

• Update    Applies changes made to the Normalize FFC to box, 

     Show flat Y check box, and Precision drop-down list. 

• Show Flat Y   Shows vertical (blue, calculated for columns) average 

     luminosity graph and image after the FFC applied to 

     columns. 

• Highlights    Highlights pixels with maximum luminosity value 

     for the test image bit depth. 

• Precision    Sets the bit depth of the tested image. 
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